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Antispam

ESET Antispam filters unsolicited email and therefore increases the
security and comfort of electronic communication.

Feature Description
Incoming Mail Allincoming mail is assigned a rating from 0
Scoring (a message is not spam) to 100 (@ message is

spam) and filtered accordingly into the Junk
Mail folder orinto a custom folder created by
the user. Parallel scanning of incoming email
is possible.

Supports aVariety of — Bayes analysis.

Scanning Techniques _ pyle-based scanning.

— Global fingerprint database check.

Full Integration with  Antispam protection is available to users

Email Clients of Microsoft Outlook, Outlook Express,
Windows Mail, Windows Live Mail and
Mozilla Thunderbird clients.

Manual Spam Option to manually select or deselect email
Selection is Available asspam.

1.2 System requirements

For seamless operation of ESET Smart Security and ESET Smart
Security Business Edition, your system should meet the following
hardware and software requirements:

ESET Smart Security:

Windows 2000, XP 400 MHz 32-bit / 64-bit (x86 / x64)
128 MB RAM of system memory
130 MB available space

Super VGA (800 x 600)

Windows Vista 1GHz 32-bit / 64-bit (x86 / x64)
512 MB RAM of system memory
130 MB available space

Super VGA (800 x 600)

ESET Smart Security Business Edition:

Windows 2000, 400 MHz 32-bit / 64-bit (x86 / x64)
2000 Server, XP, 2003 128 MB RAM of system memory
Server 130 MB available space

Super VGA (800 x 600)

Windows Vista, 1GHz 32-bit / 64-bit (x86 / x64)
Windows Server 512 MB RAM of system memory
2008 130 MB available space

Super VGA (800 x 600)

2. Installation

After purchase, the ESET Smart Security installer can be downloaded
from the ESET Web5|te It comes as awn ess_ nt**_*=* msi (ESET Smart
Security) or essbe_nt**_*** msi (ESET Smart Security Business Edition)
package. Launch the installer and the installation wizard will guide
you through the basic setup. There are two types of installation
available with different levels of setup details:

1. Typicalinstallation

2. Custominstallation

21 Typical installation

Typical installation provides configuration options appropriate for
most users. The settings provide excellent security coupled with
ease of use and high system performance. Typical installation is the
default option and is recommended if you do not have particular
requirements for specific settings.

After selecting the installation mode and clicking Next, you will
be prompted to enter your username and password for automatic
updates of the program. This plays a significant role in providing
constant protection of your system.

Enter your Username and Password, i.e., the authentication data
you received after the purchase or registration of the product, into the
corresponding fields. If you do not currently have your username and
password available, authentication data can be inserted at any time
later on, from within the user interface.



Tree - Allows you to expand or close all nodes.

List - Contains functions for easier navigation within the program as
well as various other functions like finding information online.

NOTE: Items highlighted in red are unknown and are therefore
considered potentially dangerous. If an item s in red, it does not
automatically mean that you can delete the file. Before deleting,
please make sure that the files are truly dangerous or not needed.

Help - Contains information about the application and its functions.

Detail - Influences information displayed in other sections of
Syslnspector. In Basic mode you have access to information used to
find solutions for common problems in your system. In Medium mode
the program displays less used details. In Full mode ESET SysInspector
displays detailed information needed to solve more complex
problems.

Item filtering - The most effective use of Item filtering is to find
suspicious files or registry entries in your system. By adjusting the
slider you can filter items by their Risk Level. If the slider is set to the
far left (Risk Level 1) then all items are displayed. By moving the slider
to the right, the program filters out items that are less risky than the
current Risk Level and only displays items that are more suspicious
than the displayed level. With the slider on the far right, the program
displays only known harmful items.

Allitems within the range 6 to 9 can pose a security risk. If you do not
have an ESET security solution installed, we recommend you scan your
system with the ESET Online scanner after the program has found any
high-risk items. ESET Online scanner is a free service and can be found
at http://www.eset.com/onlinescan/.

NOTE: The Risk level of an item can be determined quickly by
comparing the color of the item with the color on the Risk Level slider.

Search - Search can be used to quickly find a specificitem by its name
or part of its name. The results of search requests are displayed in the
Description window.

Return - By clicking the back or forward arrow you can return to
previously displayed information in the Description window.

Status section - Displays the current node in the Navigation window.

5.4.1.2 Navigating in ESET Syslnspector

ESET SysInspector divides various types of information into several
basic sections called nodes. If available, you may find additional
details by expanding each node into its subnodes. To anen or collapse
anode just double-click the name of the node or click ®# or =l next to
the name of the node. As you browse through the tree structure of
nodes and subnodes in the Navigation window you may find various
details for each node shown in the Description window. If you browse
through items in the Description window, additional details for each
item may display in the Details window.

Below are descriptions of the main nodes in the Navigation window
and related information in the Description and Details windows.

Running processes -This node contains information about
applications and processes running at the time the report was
generated. The Description window displays details for each process,
such as dynamic libraries used by the process and their location in the
system, the name of the application’s vendor, the risk level of the file,
etc.

The Details window contains additional information about items
selected in the Description window such as the file size or its hash.

NOTE: An operating system is comprised of several important kernel
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processes which run continually in order to provide basic functions
vital to other applications. In certain cases, such processes are
displayed in ESET SysInspector as a file path beginning with \??\. These
symbols indicate a safe and accurate configuration.

Network connections - The Description window contains a list of
processes and applications communicating over the network. The
communication protocol used is shown in the Navigation window
(TCP or UDP) along with the remote address to which the application
is connecting. You can also check DNS assigned IP addresses.

The Details window contains additional information about items
selected in the Description window such as the file size or its hash.

Important Registry Entries - Contains a list of selected registry
entries often related to various problems with your system such as
specifying startup programs, browser helper objects (BHO), etc.

In the Description window you may find which files are related to
specific registry entries. You may see additional details in the Details
window.

Services - The Description window contains a list of files registered as
Windows Services. You may check the way the service is set to start
along with specific details about the file in the Details window.

Drivers - The list of drivers installed on the system.

Critical files - The Description window displays content of critical files
related to the Microsoft Windows®operating system.

System information - Contains detailed information about hardware
and software along with information about set environmental
variables and user rights.

File details - A list of important system files and files in the Program
Files folder. Additional information specific to the files can be found in
the Description and Details windows.

About - Information about ESET SysInspector

5.41.3 Compare

The Compare feature allows you to compare two existing Sysinspector
logs in order to highlight common to both logs. This feature is useful

if you want to keep track of changes to the system and may allow you
to detect the activity of malicious code.

After launching, ESET SysInspector creates a new log, which is
displayed in a new window. Navigate to File > Save Log to save a

log to a file. Log files can later be opened and viewed. To open an
existing log, click File > Open Log. In the main program window, ESET
Syslinspector always displays one log at a time.

If you are comparing two logs, it'simportant to compare a currently
active log to alog saved in a file. To compare logs, use the option
File > Compare Log and choose Select file. The selected log will

be compared to the active one in the main program windows. The
resulting, so called comparative log will display only differences
between those two logs.

NOTE: If you compare two log files, select File > Save Log, and save
itasa.zipfile, both files are saved. If you later open this file, the
contained logs are automatically compared.

Next to the displayed items, Sysinspector shows symbols identifying
differences between the compared logs. ltems marked by a = can
only be found in the active log and were not present in the opened
comparative log. ltems marked by a * on the other hand, were
present only in the opened log and are missing in the active one.



Description of all symbols that can be displayed next to items:
<+ new value, not present in the previous log
tree structure section contains new values
= removed value, presentin the previous log only
tree structure section contains removed values
“ value / file has been changed
tree structure section contains modified values / files
M therisk level has decreased / it was higher in the previous log
# therisk level has increased /it was lower in the previous log
The explanation section displayed in the left bottom corner describes

all symbols and also displays the names of logs which are being
compared.

Compare Logs >
Current log:  SysInspector-VISTAXGS - Feb. 12 200E- 14:59 (xmil)

Previous Log:  SysInspector- KOO-Feb 21 2008-11-38 (xmnl)

Compare loons Legend:

+ Added ltem Added ltem(s) in Branch

= Removed kem Removed lemis) in Branch

2 File Replaced Added or Removed

¥ Status Got Lower Iemis) in Branch

A Status Got Higher File(z) Replzced in Branch

Any comparative log can be saved to a file and opened at a later time.

Example: - Generate and save a log, recording original information
about the system, to a file named previous.xml. After changes to the
system have been made, open Sysinspector and let it generate a new
log. Save it to a file named current.xml.

In order to track changes between those two logs, click
File > Compare Log. The program will create a comparative log
showing differences between the logs.

The same result can be achieved if you use the following command
line option:

Syslsnpector.exe current.xml previous.xml

5.4.1.4 Syslnspector as part of ESET Smart Security 4

To open Sysinspector in ESET Smart Security, click Tools >
Syslnspector. The management system in the Sysinspector window
is similar to that of computer scan logs, or scheduled tasks. All
operations with system snapshots - create, view, compare, remove
and export - are accessible within one or two clicks.

The SysIinspector window contains basic information about the
created snapshots such as create time, short comment, name of the
user that created the snapshot and snapshot status.

To Compare, Add..., or Remove snapshots, use the corresponding
buttons located below the list of snapshots in the Sysinspector
window. Those options are also available from the context menu.
To view the selected system snapshot, use the View context menu
option. To export the selected snapshot to a file, right-click it and
select Export.... A detailed description of the available options is
shown below:

Compare - Allows you to compare two existing logs. This feature is
useful if you want to track changes between the current log and an
older log. For this option to take effect you must select two snapshots
to be compared.

Add - Creates a new record. Before that you must enter a short
comment about the record. To see the snapshot creation progress (of
the currently generated snapshot) in percent, see the Status column.
All completed snapshots are marked by the Created status.

Remove - Removes entries from the list

Show - Displays the selected snapshot. Alternatively, you can double-
click the selected entry.

Export... - Saves the selected entry in an .xml file (as well as a .zip
version)

5.5 ESET SysRescue

ESET SysRescue (ESR) is a utility which enables you to create a
bootable disk containing ESET Smart Security 4 (ESS). The main
advantage of ESET Recovery CD is that ESS runs independent of the
host operating system, while it has direct access to the disk and the
entire file system. This makes it possible to remove infiltrations which
normally could not be deleted, e.g., when the operating system is
running, etc.

5.5.1 Minimum requirements

ESET SysRescue (ESR) works in the Microsoft Windows Preinstallation
Environment (Windows PE) version 2.x, which is based on Windows
Vista. Windows PE is a part of the free package Windows Automated
Installation Kit (Windows AIK), and therefore Windows AlIK must be
installed before creating ESR. Due to the support of the 32-bit version
of Windows PE, ESR can be created using the 32-bit version of ESS only.
ESR supports Windows AlK1.1and later. ESR is available in ESS 4.0 and
later.

5.5.2 How to create rescue CD

If the minimum requirements for the creation of ESET SysRescue (ESR)
CD are met, itis quite an easy task to accomplish. To launch the ESR
wizard, click Start > Programs > ESET > ESET Smart Security 4 >
ESET SysRescue.

First, the wizard checks for the presence of Windows AlK and a
suitable device for the boot media creation.

In the next step select the target media where ESR will be located. In
addition to CD/DVD/USB you can choose to save ESR in an .iso file.
Later, you can burn the .iso image on CD/DVD, or use it in other ways
(e.g., inavirtual environment such as VmWare or Virtualbox).

After you have specified all parameters, you will see a compilation
preview in the last step of ESET SysRescue wizard. Check the
parameters and start the compilation. The available options include:

Folders

ESET Antivirus
Advanced

Bootable USB device
Burning

5.5.2.1 Folders

Temporary folder - Working directory for files required during ESET
SysRescue compilation.

ISO folder - Folder where the resulting .iso file is saved after the
compilation is completed.
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The list on this tab shows all local and mapped network drives
together with the available free space. If any of the folders here are
located on a drive with insufficient free space, we recommend that
you select another drive with more free space available. Otherwise
compilation may exit prematurely due to insufficient free disk space.

External applications - Allows you to specify additional programs
that will be run or installed after booting from a SysRescue medium.

Include external applications - Allows you to add external programs
to the SysRescue compilation

Selected folder - Folder in which programs to be added to the
SysRescue disk are located
5.5.2.2 ESET Antivirus

To create an ESET SysRescue CD, you can select two sources of ESET
files to be used by the compiler.

ENA folder - Files already contained in the folder to which the ESET
product is installed on your computer

MSI file — Files contained in the .msi installer are used

Profile — You can use one of the following two sources of username
and password:

Installed ENA — Username and password are copied from the
currently installed ESET security product

From user — Username and password entered in the corresponding
text boxes below are used

NOTE: The ESET security product on the ESET SysRescue CD is
updated either from the Internet or from the computer running the
ESET SysRescue CD.

5.5.2.3 Advanced

The Advanced tab lets you optimize ESET SysRescue CD according to
your computer's memory capacity. Select 512 MB and more to write
the content of the CD to the operating memory (RAM). If you select

less than 512 MB, the recovery CD will be permanently accessed when
WInPE is running.

External drivers —This section explains how to add drivers for your
specific hardware (e.g., network adapter). Although WinPE is based
on Windows Vista SP1, which supports a large range of hardware,
occasionally hardware is not recognized. This will required that you
add a driver manually.

There are two ways of introducing a driver into an ESET SysRescue
compilation - manually (the Add button) and automatically (the Aut.
Search button). If you manually add a driver, you need to select the
path to the corresponding .inf file (applicable *.sys file must also be
present in this folder). Using the Aut. Search button automatically
locates the driver in the operating system of the given computer. We
recommend you use this option only if the original computer on which
the SysRescue disc was created and the computer you are restoring to
use the same network adapter. During creation, the ESET SysRescue
thedriverisintroduced into the compilation so you do not need to
look forit later.

5.5.2.4 Bootable USB device

If you have selected USB device as your target medium, you can select
one of the available USB media on the Bootable USB device tab (in
case there are more USB devices).

Warning: The selected USB device will be formatted during ESET
SysRescue creation. All data on the device will be deleted.
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5.5.2.5 Burn
If you have selected CD/DVD as your target medium, you can specify
additional burning parameters on the Burn tab.

Delete ISO file — Select this option to delete .iso files after the ESET
Rescue CD is created.

Deletion enabled — Allows you to select fast erasing and complete
erasing.

Burning device — Select the drive to be used for burning.

Warning: This is the default option. If a rewritable CD/DVD is used, all
data on the CD/DVD will be erased.

The Medium section contains information about the current medium
inserted in your CD/DVD device.

Burning speed - Select the desired speed from the drop-down menu.
The capabilities of your burning device and the type of CD/DVD used
should be considered when selecting the burning speed.

5.5.3 Working with ESET SysRescue

For the rescue CD/DVD/USB to work effectively, you must start your
computer from the ESET SysRescue boot media. Boot priority can be
modified in the BIOS. Alternatively, you can invoke the boot menu

during computer startup - usually using one of the F9 - F12 keys
depending on the version of your motherboard/BIOS.

After booting up, ESS will start. Since ESET SysRescue is used only in
specific situations, some protection modules and program features
present in the standard version of ESS are not needed; their list is
narrowed down to Computer scan, Update, and some sections in
Setup. The ability to update the virus signature database is the most
important feature of ESET SysRescue, we recommend that you update
the program prior starting a Computer scan.

5.5.3.1 Using ESET SysRescue

Suppose that computers in the network have been infected by a virus
which modifies executable (.exe) files. ESS is capable of cleaning all
infected files except for explorer.exe, which cannot be cleaned, evenin
Safe mode.

This is because explorer.exe, as one of the essential Windows
processes, is launched in Safe mode as well. ESS would not be able to
perform any action with the file and it would remain infected.

In this type of scenario, you could use ESET SysRescue to solve the
problem. ESET SysRescue does not require any component of the host
operating system, and is therefore capable of processing (cleaning,
deleting) any file on the disk.



6. Glossary

6.1 Types of infiltration

An Infiltration is a piece of malicious software trying to enter and/or
damage a user's computer.

6.1.1 Viruses

A computer virus is an infiltration that corrupts existing files on your
computer. Viruses are named after biological viruses, because they use
similar techniques to spread from one computer to another.

Computer viruses mainly attack executable files and documents. To
replicate, a virus attaches its"body” to the end of a target file. In short,
this is how a computer virus works: after execution of the infected
file, the virus activates itself (before the original application) and
performs its predefined task. Only after that is the original application
allowed to run. Avirus cannot infect a computer unless a user, either
accidentally or deliberately, runs or opens the malicious program by
him/herself.

Computer viruses can range in purpose and severity. Some of them
are extremely dangerous because of their ability to purposely delete
files from a hard drive. On the other hand, some viruses do not cause
any damage — they only serve to annoy the user and demonstrate the
technical skills of their authors.

Itis important to note that viruses (when compared to trojans or
spyware) are increasingly rare because they are not commercially
enticing for malicious software authors. Additionally, the term“virus”
is often used incorrectly to cover all types of infiltrations. This usage
is gradually being overcome and replaced by the new, more accurate
term“malware” (malicious software).

If your computer is infected with a virus, it is necessary to restore
infected files to their original state —i.e., to clean them by using an
antivirus program.

Examples of viruses are: OneHalf, Tenga, and Yankee Doodle.

6.1.2 Worms

A computer worm is a program containing malicious code that
attacks host computers and spreads via a network. The basic
difference between a virus and a worm is that worms have the ability
toreplicate and travel by themselves - they are not dependent on host
files (or boot sectors). Worms spread through email addresses in your
contact list or exploit security vulnerabilities in network applications.

Worms are therefore much more viable than computer viruses. Due to
the wide availability of the Internet, they can spread across the globe
within hours or even minutes of their release. This ability to replicate
independently and rapidly makes them more dangerous than other
types of malware.

Aworm activated in a system can cause a number of inconveniences:
It can delete files, degrade system performance, or even deactivate
programs. The nature of a computer worm qualifies it as a“means of
transport” for other types of infiltrations.

If your computer is infected with a worm, we recommend you delete
the infected files because they likely contain malicious code.

Examples of well-known worms are: Lovsan/Blaster, Stration/
Warezov, Bagle, and Netsky.

6.1.3 Trojan horses

Historically, computer trojan horses have been defined as a class of
infiltrations which attempt to present themselves as useful programs,
thus tricking users into letting them run. But it isimportant to note
that this was true for trojan horses in the past-today, thereis no
longer a need for them to disguise themselves. Their sole purpose

is to infiltrate as easily as possible and accomplish their malicious
goals."Trojan horse” has become a very general term describing any
infiltration not falling under any specific class of infiltration.

Since thisis a very broad category, it is often divided into many
subcategories:

Downloader — A malicious program with the ability to download
other infiltrations from the Internet.

Dropper — A type of trojan horse designed to drop other types
of malware onto compromised computers.

Backdoor —An application which communicates with remote
attackers, allowing them to gain access to a system and to take
control of it.

Keylogger - (keystroke logger) — A program which records each
keystroke that a user types and sends the information to remote
attackers.

Dialer — Dialers are programs designed to connect to premium-rate
numbers. It is almost impossible for a user to notice that a new
connection was created. Dialers can only cause damage to users with
dial-up modems, which are no longer regularly used.

Trojan horses usually take the form of executable files with the
extension .exe. If a file on your computer is detected as a trojan horse,
itis advisable to delete it, since it most likely contains malicious code.

Examples of well-known trojans are: NetBus, Trojandownloader.
Small.ZL, Slapper

6.1.4 Rootkits

Rootkits are malicious programs that grant Internet attackers
unlimited access to a system, while concealing their presence.
Rootkits, after accessing a system (usually exploiting a system
vulnerability), use functions in the operating system to avoid
detection by antivirus software: they conceal processes, files and
Windows registry data. For this reason, it is almost impossible to
detect them using ordinary testing techniques.

There are two levels of detection to prevent rootkits:

1. When they try to access a system. They are still not present,
and are therefore inactive. Most antivirus systems are able to
eliminate rootkits at this level (assuming that they actually detect
such files as being infected).

2. When they are hidden from the usual testing. ESET NOD32

Antivirus users have the advantage of Anti-Stealth technology,
which is also able to detect and eliminate active rootkits.
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6.1.5 Adware

Adware is a short for advertising-supported software. Programs
displaying advertising material fall under this category. Adware
applications often automatically open a new pop-up window
containing advertisements in an Internet browser, or change the
browser's home page. Adware is frequently bundled with freeware
programs, allowing their creators to cover development costs of their
(usually useful) applications.

Adware itself is not dangerous — users will only be bothered with
advertisements. Its danger lies in the fact that adware may also
perform tracking functions (as spyware does).

If you decide to use a freeware product, please pay particular
attention to the installation program. The installer will most likely
notify you of the installation of an extra adware program. Often you
will be allowed to cancel it and install the program without adware.

Some programs will not install without adware, or their functionality
will be limited. This means that adware may often access the system
in a“legal” way, because users have agreed to it. In this case, it is better
to be safe than sorry.If there is a file detected as adware on your
computer, itis advisable to delete it, since there is a high probability
that it contains malicious code.

6.1.6 Spyware

This category covers all applications which send private information
without user consent/awareness. Spyware uses tracking functions to
send various statistical data such as a list of visited websites, email
addresses from the user's contact list, or a list of recorded keystrokes.

The authors of spyware claim that these techniques aim to find out
more about users' needs and interests and allow better-targeted
advertisement. The problem is that there is no clear distinction
between useful and malicious applications and no one can be sure
that the retrieved information will not be misused. The data obtained
by spyware applications may contain security codes, PINs, bank
account numbers, etc. Spyware is often bundled with free versions
of a program by its author in order to generate revenue or to offer an
incentive for purchasing the software. Often, users are informed of
the presence of spyware during a program's installation to give them
anincentive to upgrade to a paid version without it.

Examples of well-known freeware products which come bundled
with spyware are client applications of P2P (peer-to-peer) networks.
Spyfalcon or Spy Sheriff (and many more) belong to a specific spyware
subcategory — they appear to be antispyware programs, butin fact
they are spyware programs themselves.

If afileis detected as spyware on your computer, it is advisable to
deleteit, since there is a high probability that it contains malicious
code.
6.1.7 Potentially unsafe applications

There are many legitimate programs whose function is to simplify
the administration of networked computers. However, in the wrong

hands, they may be misused for malicious purposes. ESET Smart
Security provides the option to detect such threats.

“Potentially unsafe applications”is the classification used for
commercial, legitimate software. This classification includes programs
such as remote access tools, password-cracking applications, and
keyloggers (a program that records each keystroke a user types).

If you find that there is a potentially unsafe application present and

running on your computer (and you did not install it), please consult
your network administrator or remove the application.
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6.1.8 Potentially unwanted applications

Potentially unwanted applications are not necessarily intended to
be malicious, but may affect the performance of your computer

in a negative way. Such applications usually require consent for
installation. If they are present on your computer, your system
behaves differently (compared to the state before their installation).
The most significant changes are:

New windows you haven't seen previously are opened
Activation and running of hidden processes
Increased usage of system resources
Changes in search results
Application communicates with remote servers
6.2 Types of remote attacks

There are many special techniques which allow attackers to
compromise remote systems. These are divided into several categories.
6.2.1 DosS attacks

DosS, or Denial of Service, is an attempt to make a computer or
network unavailable forits intended users. The communication
between afflicted users is obstructed and can no longer continuein a

functional way. Computers exposed to DoS attacks usually need to be
restarted in order to work properly.

In most cases, the targets are web servers and the aim is to make
them unavailable to users for a certain period of time.

6.2.2 DNS Poisoning

Using DNS (Domain Name Server) poisoning, hackers can trick the
DNS server of any computer into believing that the fake data they
supplied is legitimate and authentic. The fake information is cached
fora certain period of time, allowing attackers to rewrite DNS replies
of IPaddresses. As a result, users trying to access Internet websites
will download computer viruses or worms instead of their original
content.
6.2.3 Worm attacks

A computer worm is a program containing malicious code that
attacks host computers and spreads via a network. The network
worms exploit security vulnerabilities in various applications. Due
to the availability of the Internet, they can spread all over the world
within a few hours of their release. In some cases, even in minutes.

Most worm attacks (Sasser, SqlSlammer) can be avoided by using
default security settings in the firewall, or by blocking unprotected
and unused ports. Also, it is essential that your operating system is
updated with the most recent security patches.

6.2.4 Port scanning

Port scanning is used to determine which computer ports are open on
anetwork host. A port scanner is software designed to find such ports.

A computer portis a virtual point which handles incoming and
outgoing data — this is crucial from a security point of view. In a large
network, the information gathered by port scanners may help to
identify potential vulnerabilities. Such use is legitimate.



Still, port scanning is often used by hackers attempting to
compromise security. Their first step is to send packets to each

port. Depending on the response type, it is possible to determine
which ports are in use. The scanning itself causes no damage, but be
aware that this activity can reveal potential vulnerabilities and allow
attackers to take control of remote computers.

Network administrators are advised to block all unused ports and
protect those that are in use from unauthorized access.

6.2.5 TCP desynchronization

TCP desynchronization is a technique used in TCP Hijacking attacks. It
is triggered by a process in which the sequential number in incoming
packets differs from the expected sequential number. Packets with an
unexpected sequential number are dismissed (or saved in the buffer
storage, if they are present in the current communication window).

In desynchronization, both communication endpoints dismiss
received packets, at which point remote attackers are able to infiltrate
and supply packets with a correct sequential number. The attackers
can even manipulate or modify communication.

TCP Hijacking attacks aim to interrupt server-client, or peer-to-peer
communications. Many attacks can be avoided by using
authentication for each TCP segment. It is also advised to use the
recommended configurations for your network devices.

6.2.6 SMB Relay

SMBRelay and SMBRelay2 are special programs that are capable of
carrying out attacks against remote computers. The programs take
advantage of the Server Message Block file sharing protocol, which is
layered onto NetBIOS. A user sharing any folder or directory within the
LAN most likely uses this file sharing protocol.

Within local network communication, password hashes are
exchanged.

SMBRelay receives a connection on UDP port 139 and 445, relays the
packets exchanged by the client and server, and modifies them. After
connecting and authenticating, the client is disconnected. SMBRelay
creates a new virtual IP address. The new address can be accessed
using the command“net use \\192.168.1.1". The address can then be used
by any of the Windows networking functions. SMBRelay relays SMB
protocol communication except for negotiation and authentication.
Remote attackers can use the IP address, as long as the client
computeris connected.

SMBRelay2 works on the same principle as SMBRelay, except it

uses NetBIOS names rather than IP addresses. Both can carry out
“man-in-the-middle” attacks. These attacks allow remote attackers
toread, insert and modify messages exchanged between two
communication endpoints without being noticed. Computers exposed
to such attacks often stop responding or unexpectedly restart.

To avoid attacks, we recommend that you use authentication
passwords or keys.

6.2.7 ICMP attacks

The ICMP (Internet Control Message Protocol) is a popular and

widely-used Internet protocol. It is used primarily by networked
computers to send various error messages.

Remote attackers attempt to exploit the weaknesses of the ICMP
protocol. The ICMP protocol is designed for one-way communication
requiring no authentication. This enables remote attackers to trigger
so-called DoS (Denial of Service) attacks, or attacks which give
unauthorized individuals access to incoming and outgoing packets.

Typical examples of an ICMP attack are ping flood, ICMP_ECHO

flood and smurf attacks. Computers exposed to the ICMP attack are
significantly slower (this applies to all applications using the Internet)
and have problems connecting to the Internet.

6.3 Email

Email, or electronic mail, is a modern form of communication with
many advantages. It is flexible, fast and direct, and played a crucial
role in the proliferation of the Internet in the early 1990's.

Unfortunately, with a high level of anonymity, email and the Internet
leave room for illegal activities such as spamming. Spam includes
unsolicited advertisements, hoaxes and proliferation of malicious
software — malware. The inconvenience and danger to you is
increased by the fact that the cost of sending spam is minimal, and
authors of spam have many tools to acquire new email addresses.

In addition, the volume and variety of spam makes it very difficult to
regulate. The longer you use your email address, the more likely it will
end up in a spam engine database. Some hints for prevention:

If possible, don't publish your email address on the Internet
Only give your email address to trusted individuals

If possible, don't use common aliases —with more complicated
aliases, the probability of tracking is lower

Don't reply to spam that has already arrived in your inbox

Be careful when filling out Internet forms — be especially cautious
of options such as“Yes, | want to receive information”.

Use"specialized” email addresses — e.g., one for business, one for
communication with your friends, etc.

From time to time, change your email address
Use an Antispam solution

6.3.1 Advertisements

Internet advertising is one of the most rapidly growing forms of
advertising. Its main marketing advantages are minimal costs and a
high level of directness; what's more, messages are delivered almost
immediately. Many companies use email marketing tools to effectively
communicate with their current and prospective customers.

This type of advertising is legitimate, since you may be interested in
receiving commercial information about some products. But many
companies send unsolicited bulk commercial messages. In such cases,
email advertising crosses the line and becomes spam.

The amount of unsolicited email has become a problem and it shows
no signs of slowing. Authors of unsolicited email often attempt to
disguise spam as legitimate messages.

6.3.2 Hoaxes

A hoax is misinformation which is spread across the Internet. Hoaxes
are usually sent via email or communication tools like ICQ and Skype.
The message itself is often a joke or Urban Legend.

Computer Virus hoaxes try to generate fear, uncertainty and doubt
(FUD) in the recipients, bringing them to believe that there is an
“undetectable virus” deleting files and retrieving passwords, or
performing some other harmful activity on their system.

Some hoaxes work by asking recipients to forward messages to their
contacts, perpetuating the hoax. There are mobile phone hoaxes,
pleas for help, people offering to send you money from abroad, etc. It
is often impossible to determine the intent of the creator.
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If you see a message prompting you to forward it to everyone you
know, it may very well be a hoax. There are many websites on the
Internet that can verify if an email is legitimate. Before forwarding,
perform an Internet search on any message you suspect is a hoax.
6.3.3 Phishing

The term phishing defines a criminal activity which uses techniques of
social engineering (manipulating users in order to obtain confidential
information). Its aim is to gain access to sensitive data such as bank
account numbers, PIN codes, etc.

Access is usually achieved by sending email masquerading as a
trustworthy person or business (e.g., financial institution, insurance
company). The email can look very genuine, and will contain graphics
and content which may have originally come from the source it is
impersonating. You will be asked to enter, under various pretenses
(data verification, financial operations), some of your personal data —
bank account numbers or usernames and passwords. All such data, if
submitted, can easily be stolen and misused.

Banks, insurance companies, and other legitimate companies will
never request usernames and passwords in an unsolicited email.
6.3.4 Recognizing spam scams

Generally, there are a few indicators which can help you identify spam

(unsolicited emails) in your mailbox. If a message fulfills at least some
of the following criteria, it is most likely a spam message.

Sender address does not belong to someone on your contact list

You are offered a large sum of money, but you have to provide a
small sum first

You are asked to enter, under various pretenses (data verification,
Financial operations), some of your personal data — bank account
numbers, usernames and passwords, etc.

Itis written in a foreign language
You are asked to buy a product you are not interested in. If you
decide to purchase anyway, please verify that the message sender

is a reliable vendor (consult the original product manufacturer).

Some of the words are misspelled in an attempt to trick your spam
filter. For example“vaigra” instead of “viagra”, etc.
6.3.4.1 Rules

In the context of Antispam solutions and email clients, rules are tools
for manipulating email functions. They consist of two logical parts:

1. Condition (e.g., an incoming message from a certain address)

2. Action (e.g., deletion of the message, moving it to a specified
folder)

The number and combination of rules varies with the Antispam
solution. These rules serve as measures against spam (unsolicited
email). Typical examples:

1. Condition: An incoming email message contains some of the

words typically seen in spam messages
2. Action: Delete the message

42

1. Condition: An incoming email message contains an attachment
with an .exe extension

2. Action: Delete the attachment and deliver the message to the
mailbox

1. Condition: An incoming email message arrives from your
employer
2. Action: Move the message to the“Work" folder.

We recommend that you use a combination of rules in Antispam
programs in order to facilitate administration and to more effectively
filter spam.
6.3.4.1 Bayesian filter

Bayesian spam filtering is an effective form of email filtering used by

almost all Antispam products. It is able to identify unsolicited email
with high accuracy and can work on a per-user basis.

The functionality is based on the following principle: The learning
process takes place in the first phase. The user manually marks a
sufficient number of messages as legitimate messages or as spam
(normally 200/200). The filter analyzes both categories and learns, for
example, that spam usually contains the words“rolex” or“viagra”, and
legitimate messages are sent by family members or from addresses in
the user's contact list. Provided that a sufficient number of messages
are processed, the Bayesian filter is able to assign a specific“spam
index” to each message in order to determine whether it is spam or
not.

The main advantage of a Baysesian filter is its flexibility. For example,
if auseris a biologist, all incoming emails concerning biology or
relative fields of study will generally receive a lower probability
index. If a message includes words that would normally qualify it as
unsolicited, but it is sent by someone from the user’s contact list,

it will be marked as legitimate, because senders from a contact list
decrease overall spam probability.

6.3.4.2 Whitelist

In general, a whitelistis a list of items or persons who are accepted,
or have been granted permission. The term“email whitelist” defines a
list of contacts from whom the user wishes to receive messages. Such
whitelists are based on keywords searched for in email addresses,
domain names, or IP addresses.

If a whitelist works in“exclusivity mode”, then messages from any
other address, domain, or IP address will not be received. If a whitelist
is not exclusive, such messages will not be deleted, but filtered in
some other way.

A whitelistis based on the opposite principle to that of a blacklist.
Whitelists are relatively easy to maintain, more so than blacklists.
We recommend that you use both the Whitelist and Blacklist to filter
spam more effectively.

6.3.43 Blacklist

Generally, a blacklist is a list of unaccepted or forbidden items or

persons. In the virtual world, it is a technique enabling acceptance of
messages from all users not present on such a list.

There are two types of blacklist: Those created by users within their
Antispam application, and professional, regularly updated blacklists
which are created by specialized institutions and can be found on the
Internet.



Itis essential to use blacklists to successfully block spam, but they are
difficult to maintain, since new items to be blocked appear every day.
We recommended you use both a whitelist and a blacklist to most
effectively filter spam.

6.3.4.5 Server-side control

Server-side control is a technique for identifying mass spam based

on the number of received messages and the reactions of users. Each
message leaves a unique digital "footprint” based on the content of the
message. The unique ID number tells nothing about the content of
the email. Two identical messages will have identical footprints, while
different messages will have different footprints.

If a message is marked as spam, its footprint is sent to the server.

If the server receives more identical footprints (corresponding to a
certain spam message), the footprint is stored in the spam footprints
database. When scanning incoming messages, the program sends
the footprints of the messages to the server. The server returns
information on which footprints correspond to messages already
marked by users as spam.
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